
Учреждение профессионального образования 

«Колледж Казанского инновационного университета» 

Бугульминский филиал 

 

 

 

 

 УТВЕРЖДЕН 

 в составе Основной 

 образовательной программы – 

  программы подготовки специалистов среднего звена 

 протокол №6 от «26» августа 2025 г.  

 
  

  

 

 

 

 

Фонд оценочных средств 

ЕН.03 ИНФОРМАЦИОННОЕ ОБЕСПЕЧЕНИЕ 

ПРОФЕССИОНАЛЬНОЙ ДЕЯТЕЛЬНОСТИ 

программы подготовки специалистов среднего звена 

 по специальности  

54.02.01 Дизайн (по отраслям) 

 (на базе основного общего образования) 

Форма обучения - очная 

Присваиваемая квалификация  

Дизайнер 

 

 

 

 

 

 

Бугульма 2025



 

 

Фонд оценочных средств разработана на основе  ФГОС и основной 

образовательной программы подготовки специалистов среднего звена по 

специальности 54.02.01 Дизайн (по отраслям). 



3 

 

Общие положения 

Фонд оценочных средств (ФОС) предназначен для оценки 

образовательных достижений обучающихся, освоивших программу 

дисциплины «Информационное обеспечение профессиональной 

деятельности». 

ФОС включает оценочные материалы для проведения текущего и 

промежуточного контроля успеваемости.  

ФОС разработан на основании: 

программы подготовки специалистов среднего звена по специальности 

52.02.01 Дизайн (по отраслям); 

рабочей программы учебной дисциплины «Информационное 

обеспечение профессиональной деятельности». 

ФОС включает следующие виды оценочных средств: задания к 

практическим занятиям, включая формы оценки: устный опрос, 

тестирование; практические задания; лабораторные работы; вопросы, к 

экзамену. 
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2. Показатели оценки результатов освоения дисциплины, формы и 

методы контроля и оценки 

В результате освоения учебной дисциплины у обучающегося должны 

быть сформированы следующие компетенции: 

ОК 01, ОК 02, ПК 1.3.   

 

В результате освоения учебной дисциплины обучающийся должен 

уметь: 

- использовать изученные прикладные программные средства; 

- использовать средства операционных систем и сред для обеспечения 

работы вычислительной техники; 

В результате освоения учебной дисциплины обучающийся должен 

знать: 

- применение программных методов планирования и анализа 

проведенных работ; 

- виды автоматизированных информационных технологий; 

- основные понятия автоматизированной обработки информации и 

структуру персональных электронно-вычислительных машин (далее - ЭВМ) 

и вычислительных систем; 

- основные этапы решения задач с помощью ЭВМ, методах и средствах 

сбора, обработки, хранения, передачи и накопления информации. 

В результате освоения учебной дисциплины обучающийся должен 

приобрести практический опыт: 

- работы с прикладным программным обеспечением для использования 

в профессиональной деятельности; 

- использовать графический редактор для создания и реализации 

проектов в профессионально деятельности. 



 

3. Распределение типов контрольных заданий по элементам знаний и умений по темам 

Основной целью оценки освоения дисциплины является оценка умений и знаний, приобретамого практического 

опыта. 

Оценка освоения умений и знаний, приобретамого практического опыта осуществляется с использованием 

следующих форм и методов оценки: устный опрос, реферат, тестирование, выполнение практических работ, выполнение 

лабораторных работ. 

 
Содержание учебного 

материала 
ОК 1 ОК 2 ПК 1.3 

Тема 1. 

Информационные 

системы и применение 

компьютерной техники 

в профессиональной 

деятельности  

 Тест, устный опрос реферат 

 

 

Тема 2. Технические 

средства 

информационных 

технологий 

 
Устный опрос 

 

Тема 3. Приёмы 

обработки информации 

Прак. работа Прак. работа, 

лабораторная работа 

Лабораторная работа 

Тема 4. Создание и 

преобразование 

информационных 

объектов 
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Тема 5. 

Информационная 

безопасность 

   

 



 

4.Оценочные материалы 

4.1. Текущий контроль 

4.1.1. Банк тестовых заданий по темам дисцпилины 

Оценка освоения знаний (ОК2) с помощью тестов используется в 

учебном процессе по дисциплине «Информационное обеспечение» как 

контрольный срез знаний. Тесты разделены на 2 варианта, каждый из 

которых включает 12 вопросов. 

Инструкция: выберите один правильный ответ 

Тест №1 

1. Приложение выгружается из оперативной памяти и прекращает 

свою работу, если: 

1. запустить другое приложение 

2. свернуть окно приложения 

3. закрыть окно приложения 

4. переключиться в другое окно 

 

2. Панель задач служит для: 

1) переключения между запущенными приложениями; 

2) завершения работы Windows 

3) обмена данными между приложениями 

4) просмотра каталогов 

 

3. Файл – это: 

1) единица измерения информации 

2) программа или данные на диске, имеющие имя 

3) программа в оперативной памяти 

4) текст, распечатанный на принтере 

 

4. В каком варианте представления можно перемещать окно и 

изменять его размеры? 

1) в полноэкранном 

2) в нормальном 

3) в свернутом в значок 

 

5. Задано полное имя файла С:\DOC\proba.txt. Назовите имя папки, в 

котором находится файл proba.txt. 

1) txt 

2) proba.txt 

3) DOC 

4) C:\DOC\proba.txt 

 

6. Графический редактор — это программа, предназначенная для … 

1) создания и редактирования шрифта 

2) создания и обработки графических изображений 

3) построения диаграмм 
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4) построения графиков 

 

7. Минимальный объект в растровом графическом редакторе — это 

 … 

1) точка экрана (пиксел) 

2) объект 

3) палитра цветов 

4) символ 

 

8. При помощи графического редактора можно … 

1) создавать и редактировать графические изображения 

2) редактировать вид и начертание шрифта 

3) строить графики 

 

9. В цветовой модели RGB установлены параметры: 0, 0, 0. Этим 

параметрам соответствует цвет 

1) черный 

2) красный 

3) зеленый 

4) синий 

 

10. Растровый графический редактор предназначен для … 

1) обработки текстовых шрифтов 

2) создания чертежей 

3) построения графиков и диаграмм 

4) создания и редактирования рисунков 

 

11. В цветовой модели RGB установлены параметры: 255, 0, 0. Этим 

параметрам соответствует цвет: 

1) красный 

2) зеленый 

3) белый 

4) синий 

 

12. Какой из графических редакторов является редактором растровой 

графики? 

1) Adobe Illustrator 

2) Adobe Photoshop 

3) Corel Draw 

  

Ответы на Тест №1 

Вопрос Правильный ответ 

1 3 

2 1 
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3 2 

4 2 

5 3 

6 2 

7 1 

8 1 

9 1 

10 4 

11 1 

12 2 

 

Тест №2 

1. Поименованная совокупность файлов и подкаталогов – это: 

1) файл 

2) папка 

4) ярлык 

5) программа 

 

2. Файл, содержащий ссылку на представляемый объект:  

1) документ 

2) папка 

3) ярлык 

4) приложение 

 

3. Меню для данного объекта появляется при щелчке на правую 

кнопку: 

1) главное меню 

2) контекстное меню 

3) основное меню 

4) системное меню 

 

4. Файл рисунок.bmp находится в папке Рисунки, которая вложена в 

папку Мои рисунки на диске С:. Назовите полное имя файла: 

1) С:\Мои рисунки\Рисунки\рисунок.bmp 

2) Мои рисунки\Рисунки\рисунок.bmp 

3) С:\Мои рисунки\Рисунки\ 

4) С:\Рисунки\Мои рисунки\рисунок.bmp 

 

5. Основные операции, доступные в графическом редакторе: 

1) линия, круг, прямоугольник 

2) карандаш, кисть, ластик 

3) выделение, копирование, вставка 

4) наборы цветов (палитра) 
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6. Ухудшение качества изображений (пикселизация) при увеличении 

размера изображения - один из недостатков… 

1) фрактальной графики 

2) растровой графики 

3) векторной графики 

 

7. Большой размер файла — это недостаток … 

1) фрактальной графики 

2) растровой графики 

3) векторной графики 

 

8. Физический размер изображения может измеряться в … 

1) точках на дюйм (dpi) 

2) см, дюймах или пикселах 

3) пикселах 

4) м, мм, см 

 

9. В цветовой модели CMYK  применяются такие цвета … 

1) красный, зеленый, синий, черный 

2) красный, голубой, желтый, синий 

3) голубой, пурпурный, желтый, черный 

4)  голубой, пурпурный, желтый, белый 

 

10. В цветовой модели RGB применяются такие цвета … 

1) красный, зеленый, синий 

2) голубой, пурпурный, желтый 

3) красный, зеленый, желтый 

4) голубой, пурпурный, черный 

 

11. Для отображения объектов окружающего мира применяют 

графические редакторы: 

1) фрактальной графики 

2) растровой графики 

3) векторной графики 

 

12. Разрешение изображения измеряют  в … 

1) пикселах 

2) точках на дюйм (dpi) 

3) мм, см, дюймах 

 

Ответы на Тест №2 

Вопрос Правильный ответ 

1 2 
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2 3 

3 2 

4 1 

5 3 

6 2 

7 2 

8 1 

9 3 

10 1 

11 1 

12 2 

 

 

Критерии оценки:  

Оценка «отлично» - если обучающийся правильно ответил на все 

вопросы теста в отведенное время 

Оценка «хорошо» - если обучающийся правильно ответил на 80% 

вопросов теста в отведенное время 

Оценка «удовлетворительно» - если обучающийся правильно ответил 

на 60% вопросов теста в отведенное время 

Время выполнения: 20 мин 

 

4.1.2. Вопросы для устного опроса по темам 

Проверяемые результаты обучения: ОК 1, ОК2,  

1. Что такое информация и информационные технологии? 

2. Дайте классификацию современных информационных технологий 

3. Охарактеризуйте техническое обеспечение компьютерных сетей. 

4. Автоматизированные информационные технологии в сфере дизайна 

5. Структура персональных электронно-вычислительных машин 

(ЭВМ). 

6. Использовать функциональные режимы обработки текстовой 

информации в Word 

7. Использовать функции  обработки числовой информации в Excel 

8. Использовать обработку данных  средствами СУБД. 

 

4.1.3.Тематика рефератов по темам дицпилины 

Проверяемые результаты обучения: ОК 1,ОК2  

Тематика рефератов 

1. Назначение, состав, основные характеристики организационной и 

компьютерной техники 

2. Назначение и принципы использования системного и 

прикладного программного обеспечения 

3. Основные компоненты компьютерных сетей 
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4. Технология передачи данных в компьютерных сетях 

5. Принципы защиты информации от несанкционированного 

доступа 

6. Основные угрозы и методы обеспечения информационной 

безопасности. 

7. Понятие информационных технологий  

8. Средства и методы информационных технологий  

9. Основные категории свойств информационных технологий, 

процессов и явлений 

10. Анализировать информационные системы в дизайне 

11. Составить терминологический словарь в области статического 

информационного контента  

12. Процесс создания коллажа 

Критериями оценки результатов самостоятельной работы 

студентов являются: 

 уровень освоения учебного материала; 

 умение использовать теоретические знания при выполнении 

практических задач; 

 уровень сформированности общеучебных умений; 

 умение активно использовать электронные образовательные 

ресурсы, находить требующуюся информацию, изучать ее и применять на 

практике при анализе философских проблем; 

 обоснованность и четкость изложения материала; 

 умение ориентироваться в потоке информации, выделять главное; 

 умение четко формулировать проблему, предлагая ее решение; 

  умение критически оценивать решение проблемы и его последствия; 

 умение определить, проанализировать альтернативные возможности, 

варианты действий; 

 умение сформулировать собственную позицию и аргументировать 

ее. 

Критерии оценки 

Выступление студента с докладом/рефератом предполагает 

значительную самостоятельную работу студента. Реферат должен выполнять 

ряд требований: его содержание соответствовать заявленной теме; цели 

соответствовать задачам; логичность и последовательность изложения 

материала; способность к работе с литературными источниками, Интернет-

ресурсами, справочной и энциклопедической литературой; объем 

исследованной литературы и других источников информации; способность к 

анализу и обобщению информационного материала, степень полноты обзора 

состояния вопроса; обоснованность выводов; правильность оформления 

(соответствие стандарту, структурная упорядоченность, ссылки, цитаты, 

таблицы и т.д.). Общий результат складывается как сумма баллов по 
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представленным критериям. Максимальная оценка за выступление с 

докладом – 5 баллов. 

Критерий оценки Балл 

Актуальность темы 0,5 

Полное раскрытие проблемы 0,5 

Наличие собственной точки зрения 1 

Наличие презентации 1 

Наличие ответов на вопросы аудитории 0,5 

Логичность и последовательность изложения 1 

Отсутствие ошибочных или противоречивых положений 0,5 

Итого  5 

 

4.1.4. Задания для практических работ 

Проверяемые результаты обучения: ОК1, ОК2, , ПК 1.3 

Тема 3. Приёмы обработки информации 

Практическое занятие №1. 

Ввод символов. 

1. Запустите текстовый процессор, установленный на вашем 

компьютере. 

2. Введите с помощью клавиатуры: 

Буквы русского алфавита: Аа Бб Вв Гг Дд Ее Её Жж Зз Ии Йй Кк Лл 

Мм Нн Оо Пп Рр Сс Тт Уу Фф Хх Цц Чч Шш Щщ Ьь Ыы Ъъ Ээ Юю Яя 

Буквы английского алфавита: Аа ВЬ Сс Dd Ее Ff Gg Hh li Jj Kk LI 

Mm Nn Oo Pp Qq Rr Ss Tt Uu Vv Ww Xx Yy Zz 

Алфавит десятичной системы счисления: 0 1 2 3 4 5 6 7 8 9 

Алфавит римской системы счисления: I(1) V(5) Х(10) L(50) C(100) 

D(500) M(1000) 

Специальные символы (русская раскладка клавиатуры): ! » № ; % : ? * 

( ) _ + / — = \ 

Специальные символы (английская раскладка клавиатуры): ! @ # $ % л 

& * ( ) _ + | — = \ 

Произвольный текст о себе (имя, возраст, номер группы и т. д.) 

3. Сохраните файл в личной папке под именем Символы.rtf. 

 

Правила ввода текста. 

1. Запустите текстовый процессор, установленный на вашем 

компьютере. 

2. Введите текст: 

При вводе текста соседние слова отделяются одним пробелом. Знаки 

препинания (запятая, двоеточие, точка, восклицательный и вопросительный 

знаки) пишутся слитно с предшествующим словом и отделяются пробелом 

от следующего слова. 

Кавычки и скобки пишутся слитно с соответствующими словами. 
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Тире выделяется пробелами с двух сторон.  

Дефис пишется слитно с соединяемыми им словами. 

3. Введите текст, обращая внимание на соблюдение соответствующих 

правил: 

Тема «Правила ввода текста», гостиница «Малахит», шоколад 

«Алёнка», роман «Война и мир». 

Этапы создания текстового документа: ввод, редактирование, 

форматирование. 

Информация во Всемирной паутине организована в виде страниц (Web-

страниц). 

Всё-таки, Мамин-Сибиряк, жар-птица, северо-восток, Ростов-на-

Дону, Нью-Йорк. Пришлось волей-неволей остаться здесь на ночь. Горя 

бояться — счастья не видать. Москва — огромный город, город-страна. 

Конец XVII века — первая половина XIX века. 

4. Сохраните файл в личной папке под именем Правила_ввода.rtf. 

 

Вставка символов. 

Скачайте файл для работы: Вставка.rtf 

1. В текстовом процессоре откройте файл Вставка.rtf: 

Прснльнй кмпьютр: сстмнй блк (мтрнск плт, цнтрльнй прцсср, пртвн 

пмть, жсткй дек), вншн стрств, клвтр, мшь, мнтр, прнтр, кстчек клнк). 

2. В нужные места вставьте буквы, обозначающие гласные звуки, так, 

чтобы получились названия устройств персонального компьютера. 

3. Сохраните файл в личной папке под именем Устройства.rtf. 

 

Замена символов. 

Скачайте файл для работы: Замена.rtf 

1. В текстовом процессоре откройте файл Замена.rtf: 

К*литка, к*морка, к*вычки, к*блук, б*гровый, п*гром, с*тира, ур*ган, 

*кв*ланг, н*в*ждение, ср*жение. 

2. Замените символы «*» на буквы «а» или «о», чтобы слова были 

написаны правильно. 

3. Сохраните файл в личной папке под именем Слова.rtf. 

 

Автоматическая замена. 

Скачайте файл для работы: 100.rtf 

1. В текстовом процессоре откройте файл 100.rtf: 

У про 100го 100рожа 

Непро100рный дом: 

Часто в нем 100ножка 

Бродит под 100лом. 

Дорожит 100ножка 

Чи100тоюног 

И 100личной ваксой 
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Чистит 100 сапог. 

2. Для большей выразительности автор стихотворения Л. Кондратенко 

«вставил» внутрь слов цифры. Посмотрите, как будет выглядеть это 

стихотворение после замены «100» на «сто» (воспользуйтесь операцией 

замены). 

3. Сохраните документ с изменениями в личной папке под именем 

CTO.rtf. 

 

Удаление фрагментов . 

Скачайте файл для работы: Удаление.rtf 

1. В текстовом процессоре откройте файл Удаление.rtf: 

Клавиатура, джойстик, сканер, принтер. 

Монитор, графопостроитель, принтер, мышь. 

Жёсткий диск, flash-память, компакт-диск, процессор. 

Принтер, акустические колонки, наушники, микрофон. 

Системный блок, центральный процессор, оперативная память, 

жёсткий диск, блок питания. 

Системный блок, клавиатура, мышь, монитор, акустические колонки. 

Видеокарта, карта расширения, звуковая карта, сетевая карта. 

Enter, End, Esc, Delete. 

Цветной принтер, лазерный принтер, матричный принтер, струйный 

принтер. 

2. В каждой группе найдите лишнее слово (словосочетание) и удалите 

его. 

3. Сохраните файл в личной папке под именем Нет_лишнего.rtf. 

 

Перемещение фрагментов. 

Скачайте файл для работы: Перемещение.rtf 

1. В текстовом процессоре откройте файл Перемещение.rtf: 

CPU- 

RAM- 

HDD- 

Video Card — 

Sound Card — 

оперативная память, центральный процессор, видеокарта, жёсткий 

диск, звуковая карта. 

2. Создайте пары, поместив рядом с каждым англоязычным термином 

его русский аналог. 

3. Сохраните файл в личной папке под именем Пары.rtf. 

 

Копирование фрагментов. 

1. В текстовом процессоре создайте новый документ. 

2. Используя операции копирования и вставки, наберите текст 

стихотворения на английском языке: 
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Meet me in the morning. 

Meet me at noon. 

Meet me in September, 

Or the middle of June. 

Meet me at midnight. 

Meet me in the hall. 

Meet me in the summer. 

Meet me in the fall. 

Meet me in the evening. 

Meet me at eight. 

N1 meet you any time you want, 

But, please, don’t be late. 

3. Сохраните файл в личной папке под именем Стих.rtf. 

 

Склеивание и разрезание строк. 

Скачайте файл для работы: Строки.rtf 

1. В текстовом процессоре откройте файл Строки.rtf: 

Шило в мешке не утаишь. Не всё коту масленица. Кончил дело — гуляй 

смело. Готовь сани летом, а телегу — зимой. Пар кости не ломит. Без 

труда не выловишь рыбку из пруда. Не всё золото, что блестит. Слово — 

серебро, молчание — золото. Раньше встанешь — раньше работу кончишь. 

Цыплят по осени считают. Делу — время, потехе — час. Сначала подумай, 

потом начинай. Семь раз примерь, один раз отрежь. Работа страшна не 

рукам, а глазам. Дело мастера боится. 

2. Отредактируйте содержимое файла так, чтобы каждая пословица 

занимала ровно одну строку. 

3. Сохраните файл в личной папке под именем Пословицы.rtf. 

 

Изменение размера и шрифта символов. 

1. В текстовом процессоре создайте новый файл и сохраните его в 

личной папке под именем Шрифт1.rtf. 

2. Наберите фразу «Я изучаю текстовый процессор». Создайте девять 

копий этой фразы, помещая каждую из них в новой строке. 

3. Задайте для первых двух строк размер шрифта 12 пунктов, тип 

шрифта Times New Roman. 

Для второй пары строк: размер шрифта 14 пунктов, тип шрифта Courier 

New. 

Для третьей пары строк: размер шрифта 16 пунктов, тип шрифта Comic 

Sans MS. 

Для четвертой пары строк: размер шрифта 18 пунктов, тип шрифта 

Tahoma. 

Для пятой пары строк: размер шрифта 20 пунктов, тип шрифта Arial. 

4. Закройте файл Шрифт1.rtf, сохранив изменения. 
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Изменение цвета символов. 

Скачайте файл для работы: Цвет.rtf 

1. В текстовом процессоре откройте файл Цвет.rtf. 

2. Выполните форматирование текста согласно следующему описанию: 

• для заголовка задайте размер шрифта 16 пунктов, цвет шрифта 

красный; 

• для названий цветов задайте соответствующий им цвет шрифта, 

начертание — полужирное, размер — 14 пунктов; 

• для описаний цветов задайте начертание курсив и размер шрифта 12 

пунктов. 

3. Сохраните файл с изменениями в личной папке и закройте его. 

 

Индексы. 

1. В текстовом процессоре создайте новый файл и сохраните его в 

личной папке под именем Индексы.rtf. 

2. Выберите тип шрифта Arial, размер шрифта 14, начертание курсив. 

3. Наберите следующий текст: 

Единицы измерения количества информации: 

1 байт = 8 битов 

1 Килобайт =210 байтов 

1 Мегабайт =210 Кбайт = 220 байтов 

1 Гигабайт =210 Мбайт = 220 Кбайт = 230 байтов 

4. Сохраните изменения в файле и закройте его. 

 

Задание. Варианты форматирования символов. 

Скачайте файл для работы: Эффекты.rtf 

 
 

1. В текстовом процессоре откройте файл Эффекты.rtf. 
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2. Измените формат символов по образцу: 

Варианты форматирования символов 

3. Сохраните файл с изменениями в личной папке и закройте его. 

 

Варианты подчеркивания. 

1. В текстовом процессоре создайте новый документ. 

2. Шрифтом Times New Roman в 14 пунктов наберите текст и 

выполните форматирование символов по образцу: 

 
3. Сохраните файл в личной папке под именем Подчеркивание.rtf и 

закройте его. 

 

Форматирование абзацев. 

1. В текстовом процессоре создайте новый документ. 

2. Наберите черновик документа (Times New Roman, 14 пунктов, 

выравнивание по левому краю) со следующим текстом: 

 
 

3. Выполните форматирование в соответствии со следующими 

требованиями: 
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4. Сохраните файл в личной папке под именем Принтеры.rtf и закройте 

его. 

 

Форматирование абзацев. 

1. В текстовом процессоре создайте новый документ. 

2. Наберите черновик документа (Times New Roman, 14 пунктов, 

выравнивание по левому краю) с информацией о своей школе, себе и своём 

учителе: 

 
 

3. Выполните форматирование абзацев в соответствии со следующими 

требованиями: 
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4. Сохраните файл в личной папке под именем Титул.rtf и закройте его. 

 

Вставка специальных символов и формул. 

1. В текстовом процессоре создайте новый документ. 

2. Наберите следующий текст, содержащий символы, отсутствующие 

на клавиатуре: 

 
3. С помощью редактора формул наберите следующие формулы: 
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4. Сохраните файл в личной папке под именем Специальная_вставка.rtf 

и закройте его. 

 

Создание списков. 

1. В текстовом процессоре создайте новый документ. 

2. Создайте многоуровневый список «Устройства современного 

компьютера»: 
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3. Сохраните файл в личной папке под именем Устройства1.rtf. 

4. Переформатируйте список, поставив вместо номеров маркеры. 

Возможный вариант оформления представлен ниже: 
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5. Сохраните файл в личной папке под именем Устройства2.rtf и 

закройте его. 

 

Создание таблиц. 

1. В текстовом процессоре создайте новый документ. 

2. Создайте таблицу следующей структуры: 

  
3. Добавьте в таблицу нужное количество строк и внесите в них 

информацию о 5-6 файлах, хранящихся в вашей личной папке. 

4. Сохраните файл в личной папке под именем Таблица.rtf и закройте 

его. 

 

Создание схем. 

1. В текстовом процессоре создайте новый документ. 

2. Создайте схему «Форматы графических файлов»: 

 
3. Сохраните файл в личной папке под именем Cxeмa.rtf и закройте его. 

 

Вставка рисунков. 

Скачайте файл для работы: Мышь.jpg 

1. В текстовом процессоре создайте новый документ. 
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2. Вставьте в него рисунок из файла Мышь.jpg. 

 
3. Сделайте выноски с надписями основных частей мыши. 

4. Сохраните файл в личной папке под именем Мышь.rtf и закройте 

его. 

Критерии оценки:  

– наличие верного хода решения и верного ответа к предложенным 

заданиям. 

Оценка «отлично» ставится, если студент выполнил работу в полном 

объеме с соблюдением необходимой последовательности действий; в ответе 

правильно и аккуратно выполняет все записи, таблицы, рисунки, чертежи, 

графики, вычисления; правильно выполняет анализ ошибок. 

Оценка «хорошо» ставится, если студент выполнил требования к 

оценке "5", но допущены 2-3 недочета. 

Оценка «удовлетворительно» ставится, если студент выполнил работу 

не полностью, но объем выполненной части таков, что позволяет получить 

правильные результаты и выводы; в ходе проведения работы были допущены 

ошибки. 

Оценка «неудовлетворительно» ставится, если студент выполнил 

работу не полностью или объем выполненной части работы не позволяет 

сделать правильных выводов. 

 

Практическое занятие №4 

Создание, редактирование и форматирование электронных таблиц 

средствами табличного процессора. 

1.Создать таблицу по образцу. 

 
2. Наименование товаров в количестве 10 штук заполнить 

самостоятельно, напротив каждого наименования внести единицы измерения 

(штуки, килограммы, пары), а также любое количество и цену за единицу. 

3.Отформатировать заголовки (Arial, Ж, по центру). 
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4.Подобрать ширину столбцов (при помощи разделительной 

двунаправленной стрелки находящейся на линии раздела заголовков 

столбцов). 

5.Вести нумерацию в 1 м – столбце, пользуясь автозаполнением. 

6.Сделать обрамление (Жирная Красная внешняя, тонкая синяя – 

внутренняя ) 

7.Установить денежный формат в столбцах Цена, Сумма (Формат – 

Ячейка – Число – Денежный). 

9.Ввести данные. 

10.Ввести формулу в 1- ю ячейку суммы (сумма=количество*цену), 

скопировать вниз. 

11.Ввести формулу в ячейку для итоговой суммы (нажать на кнопку 

и выделить блок ячеек). 

12.Отсортировать записи в поле Наименование по алфавиту (Выделить 

ячейки таблицы без заголовков, далее Данные – Сортировка). 

13.Вставить дополнительные строки (выделить 5 строк и из 

контекстного меню выбрать Вставить). 

14.Набрать текст до и после таблицы. рис.2 

 
15.Сделать выравнивание текста. 

18.Сохранит файл под именем Товары ___№группы. 

 

1.Перейти на второй лист. 
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2.Выделить диапазон ячеек от A1 до I1 и из контекстного меню 

выбрать Формат ячеек. Во вкладке Выравнивание выставить галочку 

Переносить по словам. 

3.Создать таблицу «Доходы фирмы по городам» по образцу. рис.3 

 
4.Самостоятельно внести 10 городов, ввести выручку от реализации (6-

ти значная цифра), затраты на производство и зарплату. 

5.Просчитать выручку от реализации, валовую. прибыль, облагаемый 

доход, налог на доход предприятия, а также чистый доход фирмы для всех 

городов. 

6.Оформить таблицу по своему усмотрению. 

 

1. Перейти на третий лист и создать таблицу по образцу ниже. 

2.Выделить диапазон ячеек от A1 до I1 и из контекстного меню 

выбрать Формат ячеек. Во вкладке Выравнивание выставить галочку 

Переносить по словам. 

3.Самостоятельно внести 10 фамилий, однодневную ставку и 

количество рабочих дней. 

4.Высчитать общую зарплату, подоходный налог, профсоюзный налог, 

пенсионный налог, фонд занятости и сумму к выдаче для всех сотрудников. 

 
рис.4 

Критерии оценки:  

– наличие верного хода решения и верного ответа к предложенным 

заданиям. 

Оценка «отлично» ставится, если студент выполнил работу в полном 

объеме с соблюдением необходимой последовательности действий; в ответе 

правильно и аккуратно выполняет все записи, таблицы, рисунки, чертежи, 

графики, вычисления; правильно выполняет анализ ошибок. 

Оценка «хорошо» ставится, если студент выполнил требования к 
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оценке "5", но допущены 2-3 недочета. 

Оценка «удовлетворительно» ставится, если студент выполнил работу 

не полностью, но объем выполненной части таков, что позволяет получить 

правильные результаты и выводы; в ходе проведения работы были допущены 

ошибки. 

Оценка «неудовлетворительно» ставится, если студент выполнил 

работу не полностью или объем выполненной части работы не позволяет 

сделать правильных выводов. 

 

Практическое занятие №7 

Создание, редактирование и поиск данных в БД средствами СУБД 

Проектирование структуры базы данных. 

Создадим базу данных, где вся информация хранится в одной таблице. 

Конструирование структуры будущих таблиц базы данных. Таблицу 

будем создавать в режиме Конструктор. В ней будет 7 полей (код, фамилия, 

имя, отчество, год рождения, школа, класс) и 10 записей. Поле код - 

уникальный ключ записи (обычно используется для связи записей из разных 

таблиц). 

Ввод данных в таблицы. 

В данном варианте будет только одна таблица. Таблицу будем 

создавать в режиме Конструктор, а заполнять - в режиме таблицы, 

передвигаясь по ячейкам с помощью стрелок, клавиши табуляции или 

мышки. 

Создание формы. 

Создадим форму для ввода данных и воспользуемся ею. 

1. Создайте новую базу данных и изготовьте структуру таблицы с 

информацией о студентах «Компьютерной школы». 
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1. Вызовите программу Access. Для этого дважды щелкните по 

пиктограмме Microsoft Access. Перед вами откроется окно системы 

управления базами данных, в котором появится меню, представленное на 

рисунке ниже: 

Нажмите на кнопку Новая база данных. В появившемся поле Имя 

файла в качестве имени базы данных введите свою фамилию. Это будет 

название вашей личной базы данных. И щёлкните по кнопке Создать. 

В появившемся окне выберите Вид – Конструктор. Сохраните таблицу 

под именем Список. 
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В верхней строке вы увидите надпись Код/Счётчик – это Ключевое 

поле, поэтому мы переходим к следующей строке. В левой клетке введите 

имя поля (набирайте слово "Фамилия", а не свою фамилию) и нажмите на 

клавишу [Enter], В соседней клетке появится тип данных, по умолчанию он 

задается Текстовый. Любой другой выбирается с помощью ниспадающего 

меню. 

Напоминание. Переход от клетки к клетке осуществляется одним из 

способов: мышкой; нажатием на клавишу [Enter]; стрелками; клавишей [Tab]. 

Заполните поля в Конструкторе данными из табл. 1. Общие свойства 

поля оставляем по умолчанию (какие задает сама программа). 

 
Таблица 1. 

Сохраните таблицу, щелкнув по кнопке пиктографического меню. 

Замечание. Выбор режима работы: таблица или конструктор - 

осуществляется кнопкой 
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Перейдите в режим таблицы, щелкнув по кнопке Вид. Ввод данных вы 

будете производить в этом режиме, заполняя клетки таблицы. Значение поля 

Код будет меняться автоматически. Если закончить ввод в ячейку нажатием 

на клавишу [Enter], то маркер перейдет в следующую ячейку. 

Заполните базу данных значениями из табл. 2. 

 
Таблица 2 

Сохраните введенные данные, щелкнув по кнопке . В результате вы 

получили таблицу, с которой можно будет работать. 

Замечание. Передвижение по таблице можно производить с помощью 

клавиш со стрелками на клавиатуре, клавишей табуляции, а также щелчком 

мыши. Можно пользоваться стандартными для Windows комбинациями 

клавиш для быстрого продвижения по таблице. 

2. Выполните редактирование ячеек. 

Замените фамилию Иванникова на Иванова. Для этого выделите 

редактируемую ячейку и наберите новую фамилию. 

Замените год рождения на 1983. Для этого следует щелкнуть мышкой 

по нужной ячейке, и она откроется для редактирования. Удалите цифру 4 и 

введите вместо нее цифру 3. 

Самостоятельное задание. Внимательно просмотрите таблицу и 

исправьте свои ошибки. 

3. Выполните поиск записей по образцу. 

Установите текстовый курсор в поле Фамилия; 

Щелкните по кнопке , которая позволяет найти запись по 

введенному значению. В результате появится диалоговое окно, 

представленное на рисунке ниже: 
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Наберите в поле Образец фамилию Баранова и щелкните по кнопке 

Найти далее. 

Замечание. Если требуется найти следующую подобную за­пись, то 

щелкните мышкой по кнопке Найти далее. Поиск осуществляется в текущем 

поле, если установлен соответствующий флажок. В противном случае поиск 

идет по всем полям. При этом можно учитывать регистр. По окончании 

работы щелкните по кнопке Закрыть. 

4. Создайте формы для ввода данных. 

Порядок работы: 

Выделите таблицу Список. 

Выберите закладку Создание – Форма. 

Появится пустая форма ввода, представленная на рисунке ниже. 

 
Выберите Вид – Режим формы. 

Замечание. Значения кнопок работы с записями: 

- переход к первой записи; 
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- переход к предыдущей записи; 

- переход к следующей записи; 

- переход к последней записи; 

добавление новой записи (или нажатием клавиши [Enter] в последнем 

поле). 

5. Добавьте в базу данных записи, используя форму. 

Заполните базу данными, представленными в табл. 5. 

Замечание. Переход от поля ввода к следующему полю производится 

клавишей [Tab], [Enter] или мышкой. Для перехода к новой записи следует 

щелкнуть по кнопке . Значения поля Код будут заполняться 

автоматически. Значения поля Учебная группа выбирайте из ниспадающего 

списка (либо набрать, но только существующие группы). 

Таблица 5 

 

 
Сохраните введенные данные. Имя формы - Список. Закройте форму. 

Откройте таблицу Список. Убедитесь, что в таблице появились новые 

записи. 

Сохраните текущую таблицу. 

Щелкнув по нижней кнопке в правом верхнем углу, закройте таблицу. 

Критерии оценки:  

– наличие верного хода решения и верного ответа к предложенным 

заданиям. 

Оценка «отлично» ставится, если студент выполнил работу в полном 

объеме с соблюдением необходимой последовательности действий; в ответе 

правильно и аккуратно выполняет все записи, таблицы, рисунки, чертежи, 

графики, вычисления; правильно выполняет анализ ошибок. 

Оценка «хорошо» ставится, если студент выполнил требования к 

оценке "5", но допущены 2-3 недочета. 

Оценка «удовлетворительно» ставится, если студент выполнил работу 

не полностью, но объем выполненной части таков, что позволяет получить 

правильные результаты и выводы; в ходе проведения работы были допущены 

ошибки. 
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Оценка «неудовлетворительно» ставится, если студент выполнил 

работу не полностью или объем выполненной части работы не позволяет 

сделать правильных выводов. 

 

Практическое занятие №9 

Задание. Окружность как совершенная геометрическая форма всегда 

привлекала к себе внимание художников, архитекторов. На  рисунке 1 дан 

эскиз ворот Таврического дворца в Санкт-Петербурге. Особую воздушность 

придают воротам окружности, сплетённые в орнамент.  

  

  

Рис 1.    

Изобразите данный эскиз  в рабочей области графического редактора. 

Начните работу с простых элементов (рис 2). Затем начертите 

вертикальную среднюю линию и одну из горизонтальных. При помощи 

копирования и выделения без фона составьте элементы в нужном порядке 

и дорисуйте оставшиеся горизонтальные линии.  

  

Рис 2.  

Задание. Посмотрите на изображение храма Парфенон в Афинах на 

рисунке 45 и 44. даже сейчас это одно из самых красивых сооружений мира. 

Этот храм построен в эпоху расцвета древнегреческой математики. И его 

красота основана на многих математических законах.  

  Рис 4.  
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       Рис 5.  

 Если мы опишем вокруг фасада Парфенона прямоугольник (рис 5), то 

окажется, что его длина больше его ширины примерно в 1,6 раза. Такой  

прямоугольник назвали ЗОЛОТЫМ ПРЯМОУГОЛЬНИКОМ. Говорят, что 

его стороны образуют ЗОЛОТОЕ СЕЧЕНИЕ (такое деление целого на две 

равные части, при котором большая часть относится к целому, как меньшая к 

большей). Число 1,6 лишь приближенно, с точностью до 0,1, представляет 

величину золотого сечения.  

Изобразите рисунок 5 в рабочем поле графического редактора Paint.  

Задание. Нарисуйте кубик и составьте композицию своего имени. Для 

того чтобы кубик был ровным используем клавишу Shift. С помощью 

заливки закрасить у кубика грани. Копируем кубик и начинаем 

конструировать. При копировании кубика фон сделать прозрачным. Будте 

внимательным при построении. Ставить кубики нужно в определенном 

порядке. 

Критерии оценки:  

– наличие верного хода решения и верного ответа к предложенным 

заданиям. 

Оценка «отлично» ставится, если студент выполнил работу в полном 

объеме с соблюдением необходимой последовательности действий; в ответе 

правильно и аккуратно выполняет все записи, таблицы, рисунки, чертежи, 

графики, вычисления; правильно выполняет анализ ошибок. 
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Оценка «хорошо» ставится, если студент выполнил требования к 

оценке "5", но допущены 2-3 недочета. 

Оценка «удовлетворительно» ставится, если студент выполнил работу 

не полностью, но объем выполненной части таков, что позволяет получить 

правильные результаты и выводы; в ходе проведения работы были допущены 

ошибки. 

Оценка «неудовлетворительно» ставится, если студент выполнил 

работу не полностью или объем выполненной части работы не позволяет 

сделать правильных выводов. 
 

Практическое занятие №10 

Запускаем программу нажатием на ярлык с рабочего стола, либо через 

Пуск - CorelDRAW ( Пуск – Все программы - CorelDRAW). 

Сразу при старте программы, выводится окно для выполнения наших 

действий (по умолчанию). Из этого окна мы можем начать делать новый 

проект, открыть существующий и выполнить другие действия. Если данное 

окно не отобразилось, то с помощью Файл – Новый создаем новый проект.  

С помощью инструмента Прямоугольник, изображаем квадрат и 

поворачиваем его, чтобы он принял вид ромба. Таким же образом рисуем 

второй квадрат, поворачиваем, уменьшаем его в размере и помещаем внутрь 

первого ромба. На углах, 

между ромбами рисуем 4 

небольших круга (1) 

 

 

 

 

 

 

 

Р

исунок 1  

Заполняем все фигуры цветом, при этом, для 

большой фигуры ставим обводку контура 

толщиной примерно 4,0 т. В центре маленького ромба 

изображаем букву D для обозначения компании. Текст 

вводится с помощью инструмента  Для 

заливки фигур используем градиентную 

заливку. Пример для маленького ромба (Рис.2) 

 

Получаем: Рисунок 2 
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По левому и правому краю фигуры пишем название компании и род 

деятельности, используя шрифт . Слово DOT заполняем 

градиентной заливкой и делаем обводку контура. Используя инструмент 

Интерактивный Объем  вытягиваем фигуры, чтобы 

они приняли объемный вид. (Рис. 3) 

 
Рисунок 3 Рисунок 4 

Далее, с помощью инструмента Интерактивная тень, добавляем эффект 

тени и получаем готовый логотип (Рис.5) 

Для того, чтобы все элементы были как единое целое, а не отдельные 

фигуры, нужно их сгруппировать. Выделяем все элементы и нажимаем 

кнопку Группа  расположенную на верхней панели. 

 

Задание 

С помощью инструмента Прямоугольник рисуем фигуры, в 

соответствии с рисунком (В центре слитно расположены 4 квадрата) (Рис.1) 

Рисунок 1 Рисунок 2 

 

 

 

 

 

 

 

 

Выделяем каждый из 

центральных квадратов, нажимаем 

кнопку Преобразовать в кривую  затем инструментом 

Форма  преобразуем квадраты, чтобы они приняли следующий вид (Рис 3) 

Логотип почти готов, осталось заполнить все фигуры цветом, 

поставить утолщенный контур и  

шрифтом  написать название компании (Рис 4) 
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Рисунок 4 

Группируем все элементы нажатием  и логотип готов. 

Критерии оценки:  

– наличие верного хода решения и верного ответа к предложенным 

заданиям. 

Оценка «отлично» ставится, если студент выполнил работу в полном 

объеме с соблюдением необходимой последовательности действий; в ответе 

правильно и аккуратно выполняет все записи, таблицы, рисунки, чертежи, 

графики, вычисления; правильно выполняет анализ ошибок. 

Оценка «хорошо» ставится, если студент выполнил требования к 

оценке "5", но допущены 2-3 недочета. 

Оценка «удовлетворительно» ставится, если студент выполнил работу 

не полностью, но объем выполненной части таков, что позволяет получить 

правильные результаты и выводы; в ходе проведения работы были допущены 

ошибки. 

Оценка «неудовлетворительно» ставится, если студент выполнил 

работу не полностью или объем выполненной части работы не позволяет 

сделать правильных выводов. 

Практическое занятие № 11. 

Инструменты выделения: 

 – прямоугольное выделение; 

 – круговое выделение; 

 – лассо; 

 – многоугольное лассо; 

 – магнитное лассо. 

 Создание нового листа заданного размера. 

 Копирование выделенного фрагмента изображения на новый 

лист. 

 – движение выделенного фрагмента. 
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Задание: создать коллаж “Фиалковый ковёр” (коллаж – это 

изображение, построенное из кусочков других изображений). 

Алгоритм выполнения задания:  

1. Создать новый белый лист размером 700х700 пикселей. 

2. Поочередно открывать файлы, хранящие в себе изображения 

фиалок (рисунки 1 – 18). 

3. Выделять фиалки любым инструментом выделения. 

4. Копировать их поочередно на созданный чистый лист. 

5. С помощью инструмента , разместить фиалки таким образом, 

чтобы они заполнили весь чистый лист не оставляя пробелов (например как 

на рисунках 19 – 21). 

6. Сохранить коллаж в своей папке. 
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Примеры фиалковых коллажей: 

 
Рисунок 1. Коллаж, выполненный с помощью прямоугольного 

выделения. 
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Рисунок 2. Коллаж, выполненный с помощью кругового выделения. 

 
Рисунок 3. Коллаж, выполненный с помощью выделения от руки 

(лассо). 

На этом этапе следует практическая работа учащихся – 

непосредственное создание коллажа “Фиалковый ковер”.  

Критерии оценки:  

– наличие верного хода решения и верного ответа к предложенным 

заданиям. 

Оценка «отлично» ставится, если студент выполнил работу в полном 

объеме с соблюдением необходимой последовательности действий; в ответе 

правильно и аккуратно выполняет все записи, таблицы, рисунки, чертежи, 

графики, вычисления; правильно выполняет анализ ошибок. 

Оценка «хорошо» ставится, если студент выполнил требования к 

оценке "5", но допущены 2-3 недочета. 

Оценка «удовлетворительно» ставится, если студент выполнил работу 

не полностью, но объем выполненной части таков, что позволяет получить 

правильные результаты и выводы; в ходе проведения работы были допущены 

ошибки. 

Оценка «неудовлетворительно» ставится, если студент выполнил 

работу не полностью или объем выполненной части работы не позволяет 

сделать правильных выводов. 
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Практическое задание №12 

Запустить приложение PowerPoint. 

Создать новую презентацию с шаблоном оформления Совет 

директоров. 

Установить цветовую схему с оранжевым фоном. 

Подготовить титульный слайд. Для этого в Заголовок слайда вписать 

текст «О МОЕМ ДРУГЕ». Щелчком мыши выделить рамку «Подзаголовок 

слайда» и впишите в нем ФИО. 

Добавить новый слайд. Для этого выполнить команду меню Вставка → 

Создать слайд или на панели инструментов Форматирование нажать кнопку 

Создать слайд . 

1. Установить для этого слайда вариант разметки Заголовок и объект. 

Для этого в Области задач в верхней строке нажать на треугольник. При этом 

раскроется список, выбрать в нем вариант Разметка слайда и в списке 

Макеты текста указать Заголовок и объект. 

2. Подготовить слайды по образцу. Все необходимые картинки вы 

найдете в папке Заготовки → О моем друге. 

 

 
Сохраните работу в личной папке под именем PowerPoint1. 

Дополнительные задания 

Для презентации настроить эффекты анимации. Для этого в Области 

задач выбрать команду Дизайн слайда – Эффекты анимации и в списке 

установить вариант Плавающий. Нажать кнопку. Применить ко всем 

слайдам. 

Настроить автоматическую смену слайдов. Для этого в Области задач 

выбрать команду Смена слайдов и установить вариант Объединение по 

горизонтали. Убрать флажок по щелчку, установить флажок автоматически 

после и установить время смены слайдов 00:01. Нажать кнопку Применить ко 

всем слайдам. 

Просмотреть полученную презентацию. Для этого нажать клавишу F5. 

Сохранить презентацию. 
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Задание. Подводный мир  

1. Запустите программу Paint. 

2. Задайте рабочую область шириной 25 см и высотой 20 см. 

Примените инструмент Заливка для создания синего фона. 

3. Изобразите в нижней части рабочей области несколько камней 

(инструмент Овал) и морских водорослей (инструмент Карандаш). 

Воспользуйтесь инструментом Заливка для их закраски. 

4. Сохраните рисунок в личной папке под именем Фон. 

5. Выполните команду основного меню программы Paint. Задайте 

рабочую область шириной 5 см и высотой 3 см и нарисуйте в ней рыбку. 

Сохраните рисунок в личной папке под именем Рыбка. 

6. Запустите программу PowerPoint (Пуск → Все программы → 

Microsoft Office → PowerPoint). 

7. Озаглавьте первый слайд: Практическая работа в PowerPoint № 2, 

ФИО. 

8. Создайте второй слайд, нажав на кнопку Создать слайд. 

9. На вкладке Главная в группе Слайды щелкните мышью на кнопке 

Макет. Выберите пустой слайд (щелкните на макете пустого слайда). 

10. Вставьте на пустой слайд рисунок Фон, созданный в программе 

Paint. Для этого выполните команду Вставка → Рисунок, найдите нужный 

файл в личной папке, выделите его и щелкните на кнопке. Вставить. 

Фоновый рисунок появится в рабочем поле (на слайде) программы 

PowerPoint. 

11. На этот же слайд поместите изображения рыбки (файл Рыбка в 

личной папке) и осьминога (файл осьминог из папки Заготовки). 

12. Рыбка и осьминог появились на экране на белом фоне (в белых 

прямоугольниках). Для того, чтобы сделать фон прозрачным, выделине 

рыбку, щелкнув на ее изображении, - вокруг рыбки должна появиться рамка 

с маркерами. 

 
1. Выполните команду Формат → цвет → установить прозрачный цвет. 

2. Выполните то же действие для изображения осьминога. 
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3. Выделите рыбку. Перейдите на вкладку Анимация. В группе 

Расширенная анимация выберите. Добавить анимацию. В раскрывшемся 

списке в группе Пути перемещения выберите Пользовательский путь. 

Изобразите произвольную траекторию передвижения рыбки. 

4. Задайте траекторию передвижения осьминога. 

5. Для просмотра анимации воспользуйтесь кнопкой Просмотр на 

вкладке Анимация. 

6. Сохраните работу в личной папке под именем PowerPoint2 и 

позовите учителя. 

Дополнительные задания 

После завершения просмотра выделите один из объектов анимации и 

изучите возможности настройки анимации в группе Время показа слайдов. 

По своему усмотрению внесите изменения в параметры анимации. 

Понаблюдайте за изменениями в ходе просмотра. 

С помощью инструментов копирования и вставки (вкладка Главная) 

разместите на слайде несколько копий рыбки и настройте для них параметры 

анимации. Для просмотра готовой анимации воспользуйтесь 

функциональной клавишей F5. 

Сохраните работу 

Анимация на свободную тему. 

Самостоятельно придумайте сюжет для анимации. Дайте ему название 

и подробно опишите планируемую последовательность событий. 

Реализуйте свой проект средствами графического редактора и 

редактора презентаций. Подготовьтесь представить свою работу товарищам 

по классу. 

Настройка анимации и музыкального сопровождения. 

Задание 1. Времена года 

Запустить приложение PowerPoint. 

Выбрать по собственному желанию шаблон оформления и цветовую 

схему. 

Подготовить титульный слайд с названием презентации и ФИО. 

Добавить 4 слайда с названием времени года в заголовке. Для этого 

выполнить команду меню Вставка → Создать слайд или на панели 

инструментов Форматирование нажать кнопку Создать слайд. Для этих 

слайдов выбрать вариант разметки Заголовок, текст и объект. 

Отключить список в текстовом окне. Для этого на панели 

инструментов Форматирование отжать кнопку Маркеры. 

В текст слайдов вписать стихи: 

Снег и снег, и ель в снегу – 

В белых пачках – балерины 

Снег зажегся на лугу 

Ювелирною витриной 

Осеев Н.Н. 
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Весна, весна! Как воздух чист! 

Как ясен небосклон! 

Своей лазурию живой 

Слепит мне очи он. 

Баратынский Е.А. 

 

Ох, лето красное! 

Любил бы я тебя, 

Когда б не зной, да пыль, 

Да комары, да мухи! 

Пушкин А.С. 

 

Кроет уж лист золотой 

Влажную землю в лесу… 

Смело топчу я ногой 

Вешнюю леса красу. 

Майков А.Н. 

 

7 .Вставить фотографии с соответствующей порой года. Для этого 

щелкнуть по миниатюре. Добавит рисунок, в открывшемся окне выбрать 

необходимый файл. 

8. Настроить анимацию заголовка. Для этого выделить заголовок 

слайда и выполнить команду меню Показ слайда → Настройка анимации. 

Выбрать из списка. Добавить эффект вариант Вход → Другие эффекты… → 

Общие: вылет и установить параметр Направление – Сверху. 

9. Для текста стихотворения выбрать эффект анимации Вход → Другие 

эффекты…→Общие: Цветная пишущая машинка. Установить параметр 

Начало: После предыдущего. 

10. Для фотографии выбрать эффект анимации Вход → Другие 

эффекты… → Общие: Круговой симметричный. Установить параметр 

Скорость: Очень быстро. 

11. Настроить смену слайдов. Для этого выполнить команду Показ 

слайдов → Смена слайдов и в Области задач выбрать вариант Открывание 

вниз, убрать флажок по щелчку, установить флажок автоматически после. 

Установить время смены слайдов – 3с. Нажать кнопку Применить ко всем 

слайдам. 

12. Подключить к просмотру музыку – Чайковский «Времена года». 

Для этого перейти на первый слайд, выполнить команду меню Вставка → 

Фильмы и звук → Звук из файла… и указать на файл с мелодией. В 

появившемся диалоговом окне выбрать вариант Автоматически. 

13. Реализовать звучание музыки на протяжении всего просмотра. Для 

этого в Области задач выбрать пункт Настройка анимации, правой кнопкой 

мыши вызвать контекстное меню к звуку, выбрать пункт Параметры 

эффектов… и в открывшемся диалоговом окне установить вариант Закончить 
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после 5-го слайда, на вкладке Параметры звука установить флажок скрывать 

значок звука во время показа. 

14. Просмотреть полученную презентацию. Для этого нажать клавишу 

F5. Сохранить презентацию в личной папке под именем PowerPoint4. 

 

Задание. 

1. Запустить приложение PowerPoint. 

2. Создать новую презентацию. Установить произвольный шаблон 

дизайна слайдов. 

3. Оформить титульный слайд по образцу, поместив на него картинку 

из файла Винни1.jpg 

4. Добавить к слайдам звуковое сопровождение. Для этого выполнить 

команду меню Вставка → Фильм и звук → Звук из файла… и выбрать файл с 

песней из мультфильма. 

 
5. Реализовать звучание песни на протяжении 3 слайдов. Для этого в 

Области задач выбрать пункт Настройка анимации, выполнить двойной 

щелчок на эффекте и в открывшемся окне установить вариант Закончить 

после 3-го слайда. 

6. Создать новый слайд с разметкой Заголовок, текст, объект. Для этого 

на панели инструментов Форматирование нажать кнопку Создать слайд. В 

Области задач выбрать соответствующую разметку. Ввести текст заголовка и 

текст слайда. Вставить две картинки из файлов Винни2.jpg, Винни3.jpg 

7. Создать новый слайд с разметкой Заголовок и текст. В области 

текста поместить список создателей мультфильма. Растянуть текстовую 

рамку вниз за границу слайда. Для удобства можно уменьшить масштаб 

отображения слайда. Настроить для текста эффект анимации Вход → Другие 

эффекты…→ Сложные: Титры. В Области задач выполнить двойной щелчок 

по эффекту, в открывшемся диалоговом окне в дополнительных параметрах в 

списке. После анимации выбрать вариант. После анимации скрыть. 

 
Текст для слайда: 

Режиссеры 

Геннадий Сокольский 
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Федор Хитрук 

Сценаристы 

Федор Хитрук 

Борис Заходер 

 

Художники-постановщики 

Владимир Зуйков 

Эдуард Назаров 

 

Аниматоры 

Галина Баринова 

Эльвира Маслова 

Виолетта Колесникова 

Анатолий Солин 

Елена Малашенкова 

Юрий Бутырин 

Мария Мотрук 

Ольга Орлова 

Геннадий Сокольский 

Наталия Богомолова 

 

Оператор 

Михаил Друян 

 

Директор 

Любовь Бутырина 

 

Композитор 

Моисей Вайнберг 

 

Звукооператор 

Георгий Мартынюк 

 

Редактор 

Раиса Фричинская 

Роли озвучивали: 

 

Евгений леонов (Винни-Пух) 

Зинаида Нарышкина (Сова) 

Ия Саввина (Пятачок) 

Эраст Гарин (Ослик Иа) 

Владимир Осенев 

1. Создать четвертый слайд. Поместить на слайд файл с мультфильмом. 

Для этого выполнить команду меню Вставка → Фильм и звук → Фильм из 
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файла… В области задач выполнить двойной щелчок по эффекту. В 

открывшемся диалоговом окне на вкладке Параметры фильма установить 

флажок разворачивать во весь экран. 

2. Настроить смену слайдов. Для этого выполнить команду Показ 

слайдов → Смена слайдов и в Области задач выбрать вариант Открывание 

вниз, убрать флажок по щелчку, установить флажок автоматически после. 

Установить время смены слайдов – 3с. Нажать кнопку Применить ко всем 

слайдам. 

3. Просмотреть полученную презентацию. 

4. Сохранить презентацию в личной папке с именем PowerPoint5. 

 

Задание. Презентация «Часы» 

 
1. Запустите редактор презентаций PowerPoint. Выполните титульный 

слайд. Создайте пустой слайд. 

2. С помощью готовых фигур (вкладка Вставка) на пустом слайде 

изобразите циферблат с двумя стрелками. Это может выглядеть примерно 

так, как показано на рисунке. Чтобы циферблат был симметричным, сначала 

изобразите в центре экрана пересекающиеся горизонтальную и вертикальную 

прямые – оси симметрии. Пытайтесь рисовать рационально – копируйте 

повторяющиеся элементы, при необходимости изменяете их при помощи 

команд группы. Повернуть. 

3. Скопируйте слайд с часами в буфер обмена. Для этого: 

1. На вкладке Слайды левой панели щелкните на слайде с часами 

правой кнопкой мыши; 

2. Выберите команду Копировать в открывшемся меню. 

4. Вставьте в презентацию еще 4 копии этого слайда (кнопка Вставить 

на вкладке Главная). Всего должно получиться 5 слайдов. 

5. Внесите изменения в положение стрелок так, чтобы на них 

последовательно отмечалось: 12.00, 12.15, 12.30, 12.45, 13.00. 

6. Перейдите на вкладку анимация. В группе время показа слайдов: 

 Установите минимальную длительность перехода между слайдами 

(00,01); 

 Выберите режим смены слайдов После и установите время 1 сек 

(00:01,00); 

 Щелкните на кнопке Применить ко всем слайдам. 

7. Запустите показ презентации функциональной клавишей. 

8. Сохраните работу в личной папке под именем Часы. 

Дополнительное задание 
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Вставьте в презентацию дополнительные слайды так, чтобы на них 

отмечалось время 12.05, 12.10 и т.д. 

 

Задание.Времена года. 

Откройте презентацию «Времена года». 

Вставьте перед вторым слайдом новый слайд. В поле Заголовок слайда 

введите текст «Времена года». Выделите введенный заголовок и перейдите 

на вкладку Формат. С помощью инструментов группы WordArt придайте 

заголовку красочный вид. 

Перечислите на этом же слайде в поле текст слайда все времена года. 

На вкладке Главная при помощи инструментов группы Шрифт придайте 

списку красочный вид. 

Необходимо связать слово «зима» с соответствующим слайдом 

презентации, иначе говоря, создать гиперссылку. Для этого, выделите слово 

Зима и выполните команду Вставка → Гиперссылка. 

В окне Вставка гиперссылки выберите Связать с: ─ местом в 

документе. Выберите место в документе – слайд Зима. Подтвердите свой 

выбор щелчком на кнопке Ок. Обратите внимание, как изменилось слово 

Зима на Слайде № 2. 

Аналогичным способом создайте гиперссылки от слов «Весна», 

«Ленто» и «Осень» к соответствующим слайдам презентации. 

Создайте на каждом слайде времен года управляющую кнопку, 

обеспечивающую переход к оглавлению (к слайду № 2): 

Перейдите на вкладку Вставка; 

В группе Иллюстрации выберите инструмент Фигуры; 

В раскрывшемся списке среди управляющих кнопок выберите кнопку 

В начало; 

Вставьте на слайд выбранную кнопку подходящего размера; 

В окне Настройка действия установите переход по гиперссылке на 

слайд № 2 и подтвердите свой выбор щелчком по кнопке Ок. 

Запустите презентацию. Просмотрите слайды презентации с 

использованием гиперссылок. 

Сохраните изменения, выполненные в презентации «Времена года». 

 

Преобразование презентации PowerPoint в другие форматы 

Встроенные инструменты PowerPoint дают возможность рассылать 

слайды презентации по электронной почте, помещать их в общие папки 

Outlook, вставлять презентации в документы Word или преобразовывать в 

web-страницы, которые можно опубликовать в интрасети или через 

Интернет. 

Команды подменю Файл > Отправить (File > Send To) позволяют 

переслать слайды PowerPoint в следующие места назначения: 

Сообщение (на рецензию) (Mail Recipient (for Review)) — вставляет 

слайд в электронное письмо Outlook; 
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Вложение в сообщение (Mail Recipient (As Attachment)) - присоединяет 

файл презентации к электронному письму Outlook; 

По маршруту— отправка нескольким адресатам в определенной 

порядке; 

Участнику собрания по сети (Online Meeting Participant) —позволяет 

демонстрировать презентацию через сеть в реальном времени с помощью 

системы NetMeeting; 

Папка Exchange (Exchange Folder) — помещает презентацию в общую 

папку обмена документами между пользователями; в Microsoft Word 

(Microsoft Word) — помещает презентацию в документ Word. 

Чтобы добавить презентацию в файл Microsoft Word, выполните 

следуюхщие действия. 

Откройте презентацию План-ppt. 

Выберите команду Файл > Отправить > Microsoft Word (File > Send To 

> Microsoft Word). Появится окно диалога, показанное на рис. 15.4. 

 
Рис. 1. Выбор разметки страницы 

В разделе Разметка страницы в Microsoft Word (Page Layout In 

Microsoft Word) выберите вариант размещения слайдов и заметок на 

страницах документа Word. 

Переключатель Добавить слайды в документ Microsoft Word (Add 

Slides To Microsoft Word Document) предлагает два режима вставки 

презентации: 

Вставить (Paste) —добавляет в документ Word копию презентации, 

которая хранится в документе; 

Связать (Paste Link) — связывает документ Word с презентацией. При 

этом вы видите содержание презентации в окне Word, но исходная 

информация остается в файле данных PowerPoint. При таком подходе 
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обновление презентации влечет за собой одновременное обновление 

документа Word, однако для переноса такого документа, например, на другой 

компьютер, необходимо копировать не только документ Word, -но и саму 

презентацию, связанную с этим документом. 

Щелкните на кнопке ОК. В результате автоматически запустится 

приложение Word, откроется новый документ, в который будет вставлена 

презентация. Теперь, пользуясь широкими возможностями текстового 

процессора, вы сможете снабдить слайды необходимыми пояснениями и 

распечатать их на принтере. Промежуточным вариантом между распечаткой 

прозрачных пленок и электронным слайд-шоу является презентация, 

сохраненная в формате HTML. Полученные таким образом web-страницы 

можно опубликовать на web-узле, предоставив к ним доступ через интрасеть 

или Интерпет. Презентацией в виде web-страниц нельзя управлять, 

пользователь сам перемещается по слайдам. Но вы можете разместить на 

слайдах гиперссылки, подобные тем, которые были добавлены в файл 

План.рр1 на предыдущем занятии. Гиперссылки помогают пользователю 

ориентироваться в презентации. Давайте сохраним презентацию План.ррt в 

формате HTML. 

Выберите команду Файл > Сохранить как web-страницу (File > Save As 

Web Page). В открывшемся окне диалога выберите папку для web-страниц и в 

качестве имени введите название главного HTML-файла, с помощью 

которого будет инициирован просмотр презентации. 

Щелкните на кнопке Опубликовать (Publish). Откроется окно диалога, 

показанное на рис. 2. 

 
 

Добавление графики. Создание структурных схем, диаграмм. 

Изменение оформления слайдов 

Получение шаблона для диаграммы 

1. В PowerPoint на вкладке файл нажмите кнопку создать. 

2. В диалоговом окне Поиск шаблонов и тем в Интернете введите 

Организационная диаграмма и нажмите кнопку Начать поиск. 

3. Выберите организационную диаграмму в результатах поиска. 
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Многие аспекты диаграммы можно настроить, поэтому не следует 

выбирать один из них с помощью цвета или макета. 

4. Щелкните Создать. 

 
Если вы копируете и вставляете слайд организационной диаграммы в 

другую презентацию, то для использования формата конечной презентации в 

меню Параметры вставки выберите Использовать конечную тему. 
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5. Чтобы заменить замещающий текст собственным, щелкните внутри 

каждой фигуры, выделите текст, который вы хотите заменить, а затем 

введите свой текст. 

Замена замещающего текста 

 
Настройка организационной диаграммы 

1. Необязательно Чтобы применить другой цвет и схему оформления 

ко всему открытому шаблону, откройте вкладку конструктор на ленте и 

выберите тему из коллекции тем. 

 
2. Щелкните фигуру на организационной диаграмме и, когда на ленте 

появятся инструменты SmartArt, откройте вкладку конструктор или Формат. 

3. Выполните одно или несколько из указанных ниже действий. 

 На вкладке Конструктор: 

 
 Вкладка "Конструктор" 
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 Добавьте больше фигур в свою организационную диаграмму (чтобы 

указать больше имен) или передвиньте фигуры с помощью кнопок в группе 

Создание рисунка. 

 Измените стиль организационной диаграммы с помощью параметров 

в группе Стили SmartArt. 

 Измените цвета организационной диаграммы, нажав кнопку 

Изменить цвета. 

 Измените макет организационной диаграммы с помощью параметров 

в группе Макеты. 

 На вкладке Формат: 

 
 Вкладка "Формат" 

 Вкладка "Формат" 

 Переформатируйте текст с помощью параметров в группе Стили 

WordArt. 

 Измените фигуры с помощью параметров в группе "Стили фигур". 

 Изменение стиля и ширины линий, соединяющих фигуры SmartArt 

 Переставьте фигуры в организационной диаграмме с помощью 

группы Упорядочение. 

 Измените размер фигур в группах Размер и Фигуры. 

 

Задание. 

Для создания презентации с использованием макроса необходимо: 

1. Скачать готовый шаблон. 

Совет: макросы могут содержать вирусы. Поэтому будьте осторожны 

при использовании чужих презентаций или других программ, содержащих 

макрос. Лучше сделать работу самостоятельно и ею безопасно пользоваться. 

2. Настроить уровень безопасности компьютера, чтобы программа 

разрешила использование макроса. Для PowerPoint - это делается следующим 

образом:  
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В PowerPoint: 

• На вкладке Разработчик выбираем Безопасность макросов.  

• В появившемся окне Центр управления безопасностью выбираем 

Параметры макросов и выделяем Отключить все макросы с уведомлением. 

После этих настроек жмем ОК. 

• Закрываем презентацию и снова ее открываем. После этих 

настроек при каждом входе программа будет предупреждать: 

 

 
• Нажимаем «Включить содержимое». Теперь макрос будет 

работать. 

3. Создать презентацию в этом шаблоне. Например, сначала надо 

выделить тот объект, который мы хотим перемещать. В нашем случае - это 

заяц. Далее на вкладке Вставка в группе Ссылки выбрать Действие. В 

появившемся окне «Настройка действия» выставить флажок активации 

Запуск макроса. Так как Вы работаете в шаблоне с настроенным макросом, 

то выделится название этого макроса DragandDrop. Осталось нажать на ОК и 

все - макрос запущен. Окно «Настройка действия» можно вызвать правой 

кнопкой мыши, щелкнув по нужному объекту. Работать макрос будет только 

в режиме Показа слайдов.  

Для перемещения объекта нужно по нему просто щелкнуть 

(«прихватывать» нет необходимости) и «тащить», куда нужно. Второй 

щелчок позволяет объект «отпустить». 
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Для того чтобы слайды не переключались от любого случайного 

щелчка, надо отключить смену слайдов по щелчку. 

Совет. После демонстрации презентации (например, на уроке) при 

выходе из нее не сохраняйте изменения (если, конечно, это заранее не 

предусмотрено). Иначе все передвижения, которые делались на уроке 

сохранятся. 

Полезные кнопки 

Кроме простого передвижения объектов у макроса DragAndDrop 

имеются и другие интересные возможности. Рассмотрим некоторые из них. В 

этом нам помогут клавиши Shift и Alt. Shift+щелчок левой кнопкой мыши 

(ЛКМ) - поворот объекта на 45 градусов по часовой стрелке. 

Можно попытаться задать начальное и конечное положение объекта. В 

этом случае объект можно будет передвигать только в то положение, которое 

ему заранее задано. В любое другое место его передвинуть можно, но он там 

не зафиксируется. 

Делается это следующим образом: в режиме показа слайдов 

одновременно нажимаем Ctrl+Alt+Shift+ЛКМ по объекту, расположенному в 

начальном положении. Затем передвигаем в нужное нам положение и 

щелкаем ЛКМ снова с той же комбинацией клавиш, тем самым задавая 

конечное положение. Теперь объект сможет закрепиться только в этих двух 

точках слайда. Отменить эту операцию можно с помощью тех же клавиш. 

Критерии оценки:  

– наличие верного хода решения и верного ответа к предложенным 

заданиям. 

Оценка «отлично» ставится, если студент выполнил работу в полном 

объеме с соблюдением необходимой последовательности действий; в ответе 

правильно и аккуратно выполняет все записи, таблицы, рисунки, чертежи, 

графики, вычисления; правильно выполняет анализ ошибок. 

Оценка «хорошо» ставится, если студент выполнил требования к 
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оценке "5", но допущены 2-3 недочета. 

Оценка «удовлетворительно» ставится, если студент выполнил работу 

не полностью, но объем выполненной части таков, что позволяет получить 

правильные результаты и выводы; в ходе проведения работы были допущены 

ошибки. 

Оценка «неудовлетворительно» ставится, если студент выполнил 

работу не полностью или объем выполненной части работы не позволяет 

сделать правильных выводов. 
 

 

4.1..5. Задание для лабораторной работы 

Проверяемые результаты обучения:. ОК2,  ПК 1.3 

Тема 3. Приёмы обработки информации 

Улучшаем карандашные рисунки в Adobe Photoshop. 

Цель занятия: научиться улучшатьтрадиционный рисунок с помощью 

графического редактора.  

 
Для начала отсканируйте/сфотографируйте свой рисунок, а также 

очистите его, если это необходимо.  
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1. Перемещаем части 

Иногда определенная часть рисунка заканчивается там, где ее никогда 

не должно быть. Можете стереть ее, а затем нарисовать заново, но следы этой 

"коррекции" останутся. Давайте попробуем другой метод. 

Шаг 1 

Выберите зону, которую вы хотите переместить при помощи 

инструмента Лассо  (Lasso Tool). 

 
Шаг 2 

Используйте инструмент Перемещение  (Move Tool), чтобы 

перетянуть выделенный участок в правильное место. Снимите выделение, 

нажав Ctrl + D. 
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2. Скрываем ошибку 

Мы передвинули участок, но изменение слишком заметно. Нужно 

использовать другой инструмент, который поможет убрать погрешность. 

 
Шаг 1 

Выберите зону, которую нужно улучшить при помощи 

инструмента Заплатка  (Patch Tool) (Заплатка находится в том же меню, 

что и Точечная восстанавливающая кисть  (Spot Healing Brush)). 
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Шаг 2 

Перетяните выделение в зону, участок которой вы хотите "одолжить". 

 
Шаг 3 

Используйте Заплатку  (Patch Tool) везде, где это потребуется, тем 

самым сделав "шрамы" менее заметными. 
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3. Стираем ошибку 

Этот пункт кажется простым, но, используя неправильный ластик, мы 

можем получить поддельный эффект как на рисунке ниже: 

 
Шаг 1 

Чтобы избежать этого, перейдите в меню Окно > Наборы параметров 

для инструментов (Window > Tool Presets). Выберите 

инструмент Ластик  (Eraser Tool), а затем пункт Карандаш с 

ластиком (Pencil Eraser). 

 
Шаг 2 

Используйте его как обычно. Если вы хотите сделать ластик мягче, не 

прибегая к помощи графического планшета, измените 

его Непрозрачность (Opacity). 
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Разница не слишком заметна, но она играет большую роль для общего 

эффекта: 

 
4. Изменяем размер участков 

Изменение участка рисунка может быть сложным процессом, так как 

часто коррекции подвергается большая часть изображения. 

Шаг 1 

Дублируйте (Duplicate) слой, нажав Ctrl + J, затем скройте его (для 

этого кликните по иконке глаза слева от миниатюры). Выберите участок при 

помощи инструмента Лассо  (Lasso Tool). 
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Шаг 2 

Перейдите в меню Редактирование > Свободное 

трансформание (Edit > Free Transform) или нажмите Ctrl + T. 

Переключитесь в Режим деформации (Warp Mode). 

 
Шаг 3 

Перетяните маркеры ближе к середине, чтобы уменьшить участок 

или оттяните их к краям, чтобы увеличить. Если что-то пошло не так, 

нажмите Esc и попробуйте снова. 
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Шаг 4 

На этом этапе нам также нужно скрыть следы вмешательства. Мы 

можем "залатать" шов между измененной зоной и оригиналом, но есть 

способ проще. Включите видимость слоя-дубликата, добавьте 

ему Векторную маску  ( Layer Mask). Заполните (Fill) ее черным 

цветом, а затем закрасьте белым только ту часть, которая находится правее 

от шва. 

Если вы не понимаете, о чем идет речь, попробуйте этот быстрый урок 

по использованию Векторных масок. 

 

https://photoshop-master.ru/(http:/design.tutsplus.com/tutorials/quick-tip-layer-mask-vs-the-eraser-tool-in-adobe-photoshop--cms-24392
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5. Изменяем форму участка 

Тот же инструмент можно использовать для изменения формы 

участка: 
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Если вам необходимо больше контроля, попробуйте другой, гораздо 

более мощный инструмент: 

Шаг 1 

Перейдите в меню Фильтр > Пластика (Filter > Liquify) или 

используйте клавиатурное сокращение Ctrl + Shift + X. 

 
Шаг 2 

Используйте инструмент Деформация (Forward Warp Tool), изменив 

форму некоторых участков. Чем крупнее кисть, тем натуральнее эффект. 

Будьте осторожны: в этом режиме можно отменить только одно действие! 

Примечание переводчика - на самом деле, в фильтре Пластика 

работают те же быстрые клавиши, что и в основном окне Adobe Photoshop. 

Используйте Ctrl + Alt + Z для отмены действия, а Ctrl + Shift + Z для 

возвращения изменений. 
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Этот инструмент позволяет добиваться потрясающего эффекта! 

 
6. Добавляем тени 

В предыдущих шагах мы корректировали форму нашего персонажа. 

Теперь мы попробуем сделать несколько более сложных правок – добавим 

кое-что к рисунку. Однако, чем больше вы используете подобные коррекции, 

тем очевиднее становится компьютерное вмешательство, но иногда эффект 

того стоит. 

Шаг 1 

Дублируйте слой (Ctrl + J) и работайте с копией, оставив оригинал 

под ней. Перейдите в Режим быстрой маски  (Quick Mask Mode) (Q). 

Выберите мягкую кисть и пометьте зоны, которые хотите затемнить. 



68 

 

 
Шаг 2 

Выйдите из Режима быстрой маски (Quick Mask 

Mode). Инвертируйте (Invert) выделение, нажав Ctrl + Shift + I. Перейдите в 

меню Изображение > Коррекция > Цветовой тон/насыщенность (Image > 

Adjustment > Hue/Saturation). Сократите значение 

параметра Яркость (Lightness). 
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Шаг 3 

Используйте тот же ластик, чтобы стереть тень вокруг тела. 

 
Шаг 4 

Теперь используйте этот ластик для "смешивания" тени. Она не 

должна быть такой равномерной; сделайте ее немного "рваной". 
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Как видите, это очень радикальная коррекция, поэтому не 

переусердствуйте. Чем меньше будет финальный рисунок, тем труднее будет 

заметить вмешательство при помощи Photoshop. 

7. Добавляем блики 

Это эффект будет работать, только если объект был нарисован в 

темных тонах. В моем случае, мне нужно затемнить весь рисунок. 

Создайте Новый слой (New Layer), нажав Ctr + Alt + Shift + N и заполните 

его черным цветом при помощи инструмента Заливка  (Paint Bucket 

Tool). Сократите Непрозрачность (Opacity) этого слоя. 

 
Шаг 2 

Перейдите в Режим быстрой маски  (Quick Mask Mode) (Q) и при 

помощи мягкой кисти пометьте зоны, которые должны блестеть. 

 
Шаг 3 

Выйдите из Режима быстрой маски (Quick Mask 

Mode). Инвертируйте (Invert) выделение, нажав Ctrl + Shift + I. Кликните на 
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основной слой и Дублируйте (Duplicate) выделенную зону при помощи 

клавиатурного сокращения Ctrl + J. Перетяните слой-копию, разместив его 

над слоем с затемнением. 

 
Шаг 4 

Используйте те же техники, применяемые для работы с тенями, 

чтобы "смешать" блики. 

 
Шаг 5 

Сократите Непрозрачность (Opacity) для получения более мягкого 

эффекта. 
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8. Добавляем размытие 

Внимание: этот эффект выглядит очень "по-цифровому". После его 

применения сразу будет видно компьютерное вмешательство в работу! 

Шаг 1 

Перейдите в Режим быстрой маски  (Quick Mask Mode) (Q) и при 

помощи мягкой кисти нарисуйте обводку вокруг объекта. 

 
Шаг 2 

Выйдите из режима (Q), инвертируйте выделение (Ctrl + Shift + I). 

Перейдите в меню Фильтр > Размытие > Размытие по Гауссу (Filter > Blur 

> Gaussian Blur). 
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Будьте осторожны - на этом этапе легко перестараться! 

 
9. Делаем рисунок резче 

Чтобы сделать линии чище, даже если они были очень размыты в 

оригинальном изображении, мы перейдем в меню Фильтр > Усиление 

резкости > "Умная" резкость (Filter > Sharpen > Smart Sharpen). 
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10. Добавляем "бумажный" эффект 

Шаг 1 

Это самый популярный и самый "невинный" трюк для улучшения 

рисунков. Разместите текстуру бумаги над изображением. Измените Режим 

наложения (Blend Mode) слоя с бумагой на Умножение (Multiply). 
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Шаг 2 

Кликните правой кнопкой мыши по слоям и выберите Объединить 

слои (Flatten Image). Затем перейдите в меню Фильтр > Галерея 

фильтров (Filter > Filter Gallery). Выберите 

фильтр Текстуризатор (Texturizer), находящийся в 

папке Текстуры (Textures). Настройте параметры по своему усмотрению. 

 

 



76 

 

Шаг 3 

Последний, но важный пункт - вы можете 

воспользоваться Уровнями (Levels) (Ctrl + L), отрегулировав яркость всего 

изображения. 

 
 

Как выглядело до 

 
Как видите, есть много способов убрать недостатки ваших работ и 

даже улучшить их.  

Критерии оценки:  

– наличие верного хода решения и верного ответа к предложенным 

заданиям. 

Оценка «отлично» ставится, если студент выполнил работу в полном 

объеме с соблюдением необходимой последовательности действий; в ответе 

правильно и аккуратно выполняет все записи, таблицы, рисунки, чертежи, 

графики, вычисления; правильно выполняет анализ ошибок. 
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Оценка «хорошо» ставится, если студент выполнил требования к 

оценке "5", но допущены 2-3 недочета. 

Оценка «удовлетворительно» ставится, если студент выполнил работу 

не полностью, но объем выполненной части таков, что позволяет получить 

правильные результаты и выводы; в ходе проведения работы были допущены 

ошибки. 

Оценка «неудовлетворительно» ставится, если студент выполнил 

работу не полностью или объем выполненной части работы не позволяет 

сделать правильных выводов. 
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4.2. Промежуточная аттестация 

Вопросы к экзамену 

1. Понятие об информационных и коммуникационных технологиях. 

Состав и структура информационных технологий: комплекс технических 

средств, программное обеспечение. 

2. Программное обеспечение: виды, назначения. 

3. Информационные системы. Базы данных. 

4. Прикладное программное обеспечение. Возможности и порядок 

работы с файловыми менеджерами, программами-архиваторами и пакетами 

утилит для DOS и Windows. 

5. Технология хранения, поиска и сортировки данных (базы данных, 

информационные системы). Табличные, иерархические и сетевые базы 

данных. 

6. Локальные и глобальные компьютерные сети. Назначение и 

возможности компьютерных сетей различных уровней. 

7. Назначение и основные функции систем управления базами данных. 

8. Основные элементы базы данных. Режимы работы 

9. Создание формы и заполнение базы данных. 

10. Оформление, форматирование и редактирование данных. Способы 

сортировки информации. 

11. Организация поиска и выполнение запроса в базе данных. Режимы 

поиска. Формулы запроса. 

12. Понятие и структура отчёта. Создание и оформление отчёта, его 

модернизация, вывод на печать и копирование в другие документы. 

13. Дайте определение «компьютерной графике», объясните основные 

принципы представления изображений. 

14. Растровая графика и векторная графика и их различия. 

15. Понятие растровая графика. Опишите принцип представления 

растровых изображений, их достоинства и недостатки. Программы, 

работающие с растровой графикой, их особенности, отличия. 

16. Понятие векторная графика. Опишите принцип представления 

векторных изображений, их достоинства и недостатки. Программы, 

работающие с векторной графикой, их особенности, отличия. 

17. Специализированные графические редакторы, назначение и 

основные функции.  

18. Теории цвета и его представлении в компьютерной графике: 

понятие цвета, спектральная чувствительность глаза, цветовой диапазон, 

цветовая гамма, глубина цветов. 

19. Цветовая модель RGB.  

20. Цветовая модель CMYK. 

21. Цветовая модель Lab. 

22. Цветовая модель HSB. 
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Практические задания 

Задание 1. Создать рисунок используя Adobe Photoshop 

 
 

Задание 2. Создать рисунок используя Adobe Photoshop 

 
Задание 3. Создать рисунок используя Adobe Photoshop 
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Задание 4. Создать рисунок используя Adobe Photoshop 

 
Задание 5. Создать рисунок используя Adobe Photoshop 
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Задание 6. Создать таблицы ведомости начисления заработной платы за 

два месяца на разных листах электронной книги, произвести расчеты, 

форматирование, сортировку и защиту данных. 

 

Задание 7. Создайте табель учета рабочего времени и заработной 

платы, вида: 

 
Особое внимание прошу обратить на формулу напротив поля «Лучший 

работник». Результатом вычислений по ней должна стать фамилия 

работника. 

Задание 8. Заполните прайс и выполните расчеты в таблице: 

(пустые ячейки заполняем произвольно, а в ячейки с вопросительными 

знаками-помещаем формулы.) 

Для расчета столбца «Итог в $» рекомендуется использовать 

абсолютные ссылки. 
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Задание 9. Пусть известно, что в штате больницы состоит 6 санитарок, 

8 медсестер, 10 врачей, 3 заведующих отделениями, главный врач, 

заведующий аптекой, заведующая хозяйством и заведующий больницей. 

Общий месячный фонд зарплаты составляет 10 000 $. Необходимо 

определить, какими должны быть оклады сотрудников больницы 

 медсестра получает в 1,5 раза больше санитарки ; 

 врач - в 3 раза больше санитарки ; 

 заведующий отделением - на 30 $. больше, чем врач ; 

 заведующий аптекой - в 2 раза больше санитарки;  

 заведующий хозяйством - на 40 $. больше медсестры ; 

 главный врач - в 4 раза больше санитарки ; 

 заведующий больницей - на 20 $. больше главного врача ; 

 

Задание 10. Задание на формирование запроса в БД. 

Создать базу данных «Кадры» (Фамилия, имя, отчество, возраст,  пол 

(мужской / женский), должность, стаж, адрес). Заполнить 10 записями. 

Отобрать людей, чей стаж работы не менее 10 лет. 

 

Задание 11. Задание на формирование запроса в БД. 

Создать базу данных «Проект» в котором будут содержаться 

следующие таблицы: 

1) Ответственное лицо (Фамилия, имя, отчество, возраст, должность, 

стаж). 

2) Используемые материалы (Код материала, название материала, 

технология изготовления (особенности современного производственного 

оборудования))  

3) Проект (Фамилия, имя, отчество, проект (содержащий фото), код 

материала) 

Заполнить 10 записями. 

4) Необходимо отобрать проекты, которые используют текстиль 

 

Критерии оценок  

«отлично» /«зачтено» Обучающийся глубоко, полно и правильно 

освещает вопросы билета, проявляет глубокие 

знания темы, свободно ориентируется в задаваемых 
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ему вопросах, проявляет умение обосновывать 

ответ. Ответы на вопросы преподавателя даны в 

полном объеме. 

«хорошо» /«зачтено» Обучающийся в основном правильно и достаточно 

глубоко освещает вопросы билета, проявляет 

знание темы, но ответы на некоторые вопросы 

преподавателя даны в неполном объеме или 

недостаточно аргументированы. 

«удовлетворительно» 

/«зачтено» 

Обучающийся проявляет знания в целом по 

вопросам билета, но затрудняется более глубоко 

обосновать те или иные положения, на отдельные 

вопросы преподавателя ответы не даны. 

«неудовлетворительно» 

/«незачтено» 

Обучающийся не раскрывает содержание вопросов 

билета, на большую часть вопросов, заданных 

преподавателем, ответы не даны. 

 


